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Chapter 4: Analyzing your Data

PRE-TEST

1.
   Which of the following is not a cell range?


A)
B4:C6


B)
A1:AA1


C)
D3


D)
3D

Answer: D   Level: Easy   Page: EX 170     Section: 4.1
2.
   What would you do to help document and double-check the cell references in a worksheet?


A)
CHOOSE: Insert ( Name ( Paste and CLICK: Paste List command button

B)
CHOOSE: Insert ( Name ( Define and CLICK: Paste List command button

C)
PRESS: [image: image1.png]


+[image: image2.png]


 and CLICK: Paste List command button

D)
Use your note pad

Answer: A   Level: Easy   Page: EX 174     Section: 4.1.2

3.   
If a formula adjusts itself automatically when copied, the cell reference is 

A)
Relative


B)
Automatic 


C)
Absolute


D)
Mixed

Answer: A   Level: Easy   Page: EX 175     Section: 4.1.3

4.   
What menu command allows you to confirm that the names you choose are not already defined in the dialog box

A)
Edit ( Name ( Create

B)
Insert ( Name ( Create

C)
Insert ( Name ( Define

D)
Range ( Name ( Create
Answer: C   Level: Easy   Page: EX 179     Section: 4.1.4

5.
   Which of the following will let you enter a function into a worksheet cell?


A)
[image: image3.png]


  + f


B)
Insert ( Function command
C) ([image: image4.png]


)

D) both B and C will work

Answer: D   Level: Easy   Page: EX 180     Section: 4.2
6.   
Which is the correct expression for adding the values stored in the cell range from A1 to A20?


A)
=ADD(A1+A20)


B)
=AutoSUM(A1,A20)


C)
=SUM(A1+A20)

D)
=SUM(A1:A20)
Answer: D   Level: Easy   Page: EX 181     Section: 4.2.1
7.
   As you enter the function arguments in a formula, the cell range is highlighted. What is this feature called?


A)
Shading


B)
Border


C)
Range Finder


D)
Highlighter

Answer: C   Level: Easy   Page: EX 181     Section: 4.2.1  
8.   
The COUNT function:

A)
counts the number of cells in a range that contain only numeric values.

B)
counts the number of cells in a range that contain numeric or date values.

C)
counts the number of cells in a range that contain only date values.

D)
includes text labels in its calculations.
Answer: B   Level: Easy   Page: EX 184     Section: 4.2.3

9.
   The formula “=MIN(Grade)” will pull out


A)
 Minimum grade value in range “grade”

B)
 maximum grade value in range “grade”
C) minimum or maximum grades in a range

D) minimum and maximum grades in a range
Answer: A   Level: Easy   Page: EX 186     Section: 4.2.4

10.
   Which function will you use to display the current date and time in your worksheet?

A)
NOW


B)
TODAY


C)
DATE


D)
TIME

Answer: A   Level: Easy   Page: EX 188     Section: 4.2.5
11.
   Which of the following functions allows you to use conditional logic in your worksheets?


A)
The AVERAGE function


B)
The DATE function


C)
The TODAY function


D)
The IF function
Answer: D   Level: Easy   Page: EX 192     Section: 4.2.5
12.   
Which chart shows the proportions of individual components compared to the total:


A)
XY scatter plot diagram

B)
line chart 

C)
column chart

D)
Pie chart

Answer: D   Level: Easy   Page: EX 194     Section: 4.3
13.   To select a different chart sub-type that amalgamates (adds together) the data series in a column:

A)
CLICK: chart sub-type 

B)
CLICK: chart type

C)
CLICK: standard types
            D)  CLICK: custom types
Answer: A   Level: Easy   Page: EX 196     Section: 4.3.1
14.  When you CHOOSE: File ( Print Area ( Set Print Area, the dashed border around your data and chart represents
            A)
a pattern

B)  the specified print range for the worksheet

C)
Highlighting
            D)  marquee
Answer: B   Level: Easy   Page: EX 201     Section: 4.3.2
15.   Which of the following tabs is not there when you are previewing an embedded chart?

            A)
Zoom

B)  Print

C)
Set up
            D)  Set printer

Answer: D   Level: Easy   Page: EX 201     Section: 4.3.2
T   F 16.
Although the term cell range is generally used to describe a “from here to there” area on a worksheet, it cannot cover a three-dimensional area, crossing more than one worksheet within a workbook.
Answer: False   Level: Easy   Page: EX 170     Section: 4.1

T   F 17.
Once you have created range names, you cannot modify or delete them.

Answer: False   Level: Easy   Page: EX 173     Section: 4.1.2

T   F 18.
Syntax is the precise order, in which you enter arguments (labels, values, or cell references) into a worksheet cell.

Answer: True   Level: Easy   Page: EX 180     Section: 4.2

T   F 19.
If you needed current date and time in your worksheet you will use date function =TODAY()
Answer: False   Level: Medium   Page: EX 203
 T   F  20.
In the list tabulating grades values obtained by students you can find the minimum value in that range by using =MAX (range)

Answer: False   Level: Medium   Page: EX 203
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POST-TEST

1.
   If the value for Revenue is stored in C5 on Sheet1 and the value for Expenses is stored in C6 on Sheet2, the formula, revenue –expense would read:

A)
=Sheet1@C5-Sheet2@C6


B)
=Sheet1$C5-Sheet2$C6


C)
=Sheet1!C5-Sheet2!C6


D)
=Sheet1!C6-Sheet2!C5

Answer: C   Level: Medium   Page: EX 170     Section: 4.1

2.
   The Name Box is located at

A)
the far left of the Formula bar

B)
the far right of the Formula bar

C)
Just below the Formula bar

D)
Just above the Formula bar
Answer: A   Level: Medium   Page: EX 170     Section: 4.1.1

3.
   F2004 is unacceptable range name because

A)
Excel can create range names only from labels

B)
it refers to an actual cell address on the worksheet

C)
there is no gap between F and 2004


D)
It is an acceptable range name

Answer: B   Level: Easy   Page: EX 173     Section: 4.1.1

4.   
Which of the following is an absolute cell address?


A)
$B$5

B)
B5

C)
B$5

D)
($)
Answer: A   Level: Easy   Page: EX 175     Section: 4.1.3

5.   
When the formula“=B6*(1+B3)”in cell B6 is copied to cell D6:


A)
Copying and pasting has modified the cell addresses by automatically adjusting the column letters

B)
the cell references do not change.

C)
the cell references also change to reflect their relative positions on the worksheet.

D)
Both A and C are right
Answer: D   Level: Easy   Page: EX 176     Section: 4.1.3

6.
   To determine the average, median, minimum, and maximum values for a range; calculate statistical measures, like variance and standard deviation we use function category:


A)
Financial


B)
Date & Time


C)
Math & Trig


D)
Statistical 

Answer: D   Level: Easy   Page: EX 180     Section: 4.2

7.
   To determine the average of a list of nonadjacent values:

A)
separate the items in the list using commas

B)
separate the items in the list using dollar signs

C)
separate the items in the list using ! sign

D)
separate the items in the list using : sign
Answer: A   Level: Medium   Page: EX 184     Section: 4.2.2

8.
   To find the lowest grade achieved among three students (Wayne, Garth and Luce):


A)
TYPE: =min($Wayne,$Garth,$Luce), PRESS: [image: image5.png]




B)
TYPE: =min(Wayne+Garth+Luce), PRESS: [image: image6.png]




C)
TYPE: =min(Wayne,Garth,Luce), PRESS: [image: image7.png]




D)
TYPE: =min(!Wayne,!Garth,!Luce), PRESS: [image: image8.png]



Answer: C   Level: Easy   Page: EX 186     Section: 4.2.4
9.
   When you select the NOW function in the Select a function list box, the description below the list box says:

A)
Returns the computer’s internal time

B)
Returns the current time

C)
Returns the current date

D)
Returns the current date and time
Answer: D   Level: Easy   Page: EX 189     Section: 4.2.5

10.   
An embedded chart is: 

A)
placed and then entered into a cell range

B)
placed over but not entered into a cell range

C)
pasted over a cell range

D)
becomes the cell range
Answer: B   Level: Easy   Page: EX 195     Section: 4.3.1

11.   The selection boxes that appear around the selected chart object are used to :

            A)
View a chart

B)
Delete a chart

C)
Size a chart
            D)  floats a chart
Answer: C   Level: Easy   Page: EX 198     Section: 4.3.1

12.   After moving the chart to the desired place how will you return focus to the worksheet?
            A)
CLICK: any visible cell in the worksheet area, such as cell A1

B)
press [image: image9.png]Tab





C)
CLICK: [image: image10.png]



            D)  PRESS: [image: image11.png]



Answer: A   Level: Easy   Page: EX 199     Section: 4.3.1

13.   Which of the following cannot be manipulated in the page setup option?

            A)
Margins

B)  Headers.

C)
Footers
            D)  Number of copies

Answer: D   Level: Easy   Page: EX 200     Section: 4.3.2

 14.  To remove the selection highlighting from the worksheet area:

            A)
CLICK: OK command button

B)  CLICK: [image: image12.png]




C)
CLICK: cell A1
            D)  PRESS: [image: image13.png]



Answer: C   Level: Easy   Page: EX 201     Section: 4.3.2
15.   The black selection boxes that surround the chart indicate: 

            A)
that it is currently selected

B)
that it is currently not selected

C)
that it is ready to move
            D)  that it is fixed in the cell range
Answer: A   Level: Easy   Page: EX 199     Section: 4.3.1

T   F 16.
Absolute reference is Excel’s default cell reference.

Answer: False   Level: Easy   Page: EX 175     Section: 4.1.3

 T   F 17.
When a formula in a cell is copied to another cell the, cell references in the formula also change to reflect their relative positions on the worksheet

Answer: True   Level: Easy   Page: EX 175     Section: 4.1.3

T   F 18.
The COUNT function ignores cells containing text labels.
Answer: True   Level: Easy   Page: EX 184     Section: 4.2.3

T   F 19.
Specifying an absolute cell address by adding dollar signs ($) serves to anchor a cell reference to an exact location on the worksheet.
Answer: True   Level: Easy   Page: EX 202
T   F 20.
PRESSING: [image: image14.png]


 (ABS key) is a shortcut to apply absolute reference type
Answer: True   Level: Medium   Page: EX 202
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Chapter 4 introduces how to Create, modify, remove, and apply range names, understand absolute and relative cell addresses, use natural language formulas in a worksheet, use mathematical and statistical functions, such as SUM, AVERAGE, COUNT, MIN, and MAX, use date functions, such as NOW and TODAY, embed, move, and size a chart on a worksheet, and Preview and print a chart.

Prerequisites, Teaching Tips and Strategy

To successfully complete this chapter, students must be able to enter values, dates, and simple formulas into a worksheet. They will be asked to select multiple cell ranges, modify worksheet information, and access Excel 2003 features using the toolbar and menus. The final module on creating embedded charts assumes no prior charting knowledge, but students need to know how to preview and print a worksheet.

Pay special attention when teaching cell references, and how students input cell references.  Novice students can be easily confused if they choose to use the mouse to point (and click) at another cell, creating a reference in a formula.  It may be considered good practice to have students rely on keyboard entry of cell references until they have mastered formula entry.

Section 4.1 - Working with Named Ranges

Section 4.1 introduces conception and management of named ranges, cell referencing within formulas, and the use of natural language formulas.

Section 4.1.1 - Naming Cell Ranges

Feature:
To name a cell range using the Name Box:

Method:
To name a cell range using the Name Box, select the desired range and choose one of the following methods:

· Click in the Name box above the worksheet, type a name for the range and press Enter.
· To name a cell range using the Menu bar, select the desired range, including the row and column headings and choose Name from the Insert menu.  Choose Create. This displays the Create Names dialog window.  In the window, check the boxes (Top row, Left column, Bottom row, and Right column) where the headers are located and press the OK button.  

Notes:
Excel can create range names only from labels, not values. You must also beware of conflicts with cell addresses. 

Section 4.1.2 - Managing Range Names

Feature:
To display the Define Name dialog box (to add or delete named ranges):

Method:
To display the Define Name dialog box, choose Name from the Insert menu then, choose Define.  Then, use one of the following steps:

· To delete a named range, select the desired range name and press Delete button

· To add a named range, provide a name for the new named range by editing the text in the Names in Workbook: text area, and by providing a range in the Refers to: text area.  Then, click the Add button to add the new named range.

Notes:
None.

Feature:
To paste range names (and their references) into the worksheet: 

Method:
To paste the current list of named ranges and their references into a worksheet, select a cell in the worksheet where the items will be pasted then, choose Name from the Insert menu, and choose Paste.

Notes:
Efficient use of range names in place of cell references, reduce data entry errors when constructing complex formulas. For frequently refered cells on a worksheet, consider naming the cell ranges immediately. You can always delete, rename, or redefine these range names at a later date.

Section 4.1.3 - Using References in Formulas

Feature:
To use cell references:

Method:
There are two types of references to a cell in Excel.  They are as follows:

· Relative (the default) - adjusts itself automatically when copied, since the cell reference is relative to where it sits in the worksheet (example: B4)

· Absolute - always refers to an exact cell location in the worksheet. (example: $B$4)

A Mixed cell address on the other hand, locks only a portion of a cell address by placing the dollar sign before either the address’s column letter or row number and makes the other portion relative (example: $B4)

Notes:
When editing a cell, users can repeatedly press the F4 key, Excel cycles through possible combinations of relative, absolute, and mixed cell addressing.

Section 4.1.4 - Entering Natural Language Formulas

Feature:
To use a natural language expression in a formula:

Method:
To enable this feature, choose Options from the Tools menu and click the Calculation tab in the dialog window that appears.  Select the Automatic option button and the Accept labels in formulas button.  Click the OK button.  

                        To create a formula based upon natural language, select the cell where you want the result to appear, type = (an equal sign), type an expression, such as Revenue-Expenses, using the actual row and column labels and press Enter.

Notes:
In order for natural language formulas to work effectively, the worksheet must be organized in a table format with distinctly labeled rows and columns.

Section 4.2 - Using Built-In Functions

Section 4.2 introduces some of the most common functions in Excel 2003 including the SUM, AVERAGE, COUNT, MIN, MAX, NOW and TODAY functions.  

Section 4.2.1 - Adding Values (SUM)

Feature:
To Use the SUM function:

Method:
Use the SUM function to add the values appearing in a range of cells.  The function takes the form of =SUM (range).  

Notes:
the AutoSum button inserts the SUM function into a worksheet cell automatically.  

                        You can enter a function’s name and arguments using either lowercase or uppercase letters.

Section 4.2.2 - Calculating Averages (AVERAGE)

Feature:
To use the AVERAGE function:

Method:
Use the AVERAGE function to compute the average value (sometimes called the arithmetic mean) for a range of cells.  The function takes the form of =AVERAGE (range).  

Notes:
None.

Section 4.2.3 - Counting Values (COUNT)

Feature:
To use the COUNT function:

Method:
Use the COUNT function to count the number of cells in a range that contain numeric or date values.  The function takes the form of =COUNT (range).  

Notes:
The COUNT function has a second cousin named the COUNTA function. Whereas COUNT tallies the cells containing numbers and dates, COUNTA counts all nonblank cells. The primary difference, therefore, is that the COUNTA function includes text labels in its calculations.
Section 4.2.4 - Analyzing Values (MIN and MAX)

Feature:
To use the MIN and MAX functions:

Method:
Use the MIN and MAX functions to determine the minimum (lowest) and maximum (highest) values in a range of cells.  The functions take the form of =MIN(range) and =MAX(range).  

Notes:
None.

Section 4.2.5 - Calculating Dates (NOW and TODAY)

Feature:
To use the NOW function:

Method:
The NOW function returns the current date and time as provided by your computer's internal clock.  The function takes the form of =NOW() and requires no arguments

Notes:
None.

Feature:
To use the TODAY function:

Method:
The TODAY function returns the current date from the computer's internal clock.  The function takes the form of =TODAY() and requires no arguments.  

Notes:
None.

Section 4.3 - Creating an Embedded Chart

Section 4.3 gives an introduction to creating visually stunning worksheets and charts in Excel 2003 by using the Chart Wizard, and to previewing and printing the chart. Students learn how to create and print an embedded chart.

Section 4.3.1 - Creating a Chart Using the Chart Wizard

Feature:
To create a chart with the Chart Wizard:

Method:
To create an embedded chart in the workbook, select the cell range to plot in a chart.  Click the Chart Wizard button on the Standard toolbar.  The Chart Wizard dialog window will guide the user through the selection and creation of a chart based on the selected range.  Complete the steps in the Chart Wizard. (Use the Next > button to navigate through the pages of the wizard. Items which are presented for control and modification include the type of chart to be created, the source range used to create the chart, chart title and axis labels and how to embed the chart (within the current worksheet's page or as a worksheet unto itself).  Click the Finish button to complete the chart creation and embed the created chart.

Notes:
An embedded chart is actually placed over—not entered into—a cell range. Once it is embedded, you can move, size, and delete the chart at anytime.

Section 4.3.2 - Previewing and Printing an Embedded Chart

Feature:
To Preview a worksheet to ensure an embedded chart is present for printing:

Method:
To ensure an embedded chart is present for printing, use the print preview feature.  Select a cell range that includes the chart, choose Print Area from the File menu, and choose Set Print Area to set the printing area from the selection.  Then, choose the Print Preview menu item from the File menu to view the selected range in print preview mode.  

Notes:
You must ensure that the print area (or worksheet range) includes the entire chart object.  Also, remember to preview your worksheet 
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Activity 1 Create a named range in the “Music Collection” spreadsheet for each CD listed.  Use either the Name box or the Define Name dialog window to create the names.  Save the worksheet when you are done.

Activity 2 Modify the “My Grades” worksheet to include formulas which will calculate the average, minimum and maximum grades for the assignments listed in the spreadsheet.  Don’t use the AutoSum feature when building the formulas; enter the function references by hand!

Activity 3 Create a graph in the “My Grades” worksheet which shows your assignment results over time.  Select the most appropriate graph and include a title and x and y-axis labels for the graph.  Include it on the same worksheet page as the data that it represents.
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Answers to End-of-Chapter Review Questions

Short Answer

1. You name a range of cells in order to make it easier to construct formulas, enter functions, navigate the worksheet, and document formulas in a worksheet for another person to read.

2. You select the desired location in the worksheet and then choose the Insert ( Name ( Paste command. In addition to the list of names, this command enters the related cell reference for each range.

3. The two types of cell references are absolute and relative. An absolute cell reference refers to an exact location on a worksheet. A relative cell reference refers to a relative cell location and, when copied within a formula, automatically adjusts itself.

4. The worksheet should be organized using a table format with distinctly labeled rows and columns.

5. You use the MAX function in the form =MAX(salary). (Note: You can enter the function using either uppercase or lowercase.)

6. You use the NOW function in the form =NOW(). You may also want to format the cell so that it only displays the time and not the date.

7. The Insert Function dialog box is accessed by clicking the Insert Function button ([image: image15.png]


) or by choosing the Insert ( Function command.

8. The Function Arguments dialog box is accessed by entering a function name with its opening parenthesis, such as =average(, and then clicking the Insert Function button ([image: image16.png]


).

9. The Chart Wizard dialog box includes the following four steps:
( Chart Type
( Chart Source Data
( Chart Options
( Chart Location

10. The black boxes surrounding an embedded chart are called "selection boxes." However, the term “sizing handles” is also used frequently. The selection boxes are used to adjust the size of the chart object using the mouse. 

True/False

	1.
	F
	6.
	T

	2.
	F
	7.
	F

	3.
	T
	8.
	T

	4.
	F
	9.
	T

	5.
	F
	10.
	T


Multiple-Choice

	1.
	B
	6.
	A
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	C
	7.
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	3.
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	8.
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	9.
	B

	5.
	D
	10.
	D


